
Adobe Bridge
Always use for Photoshop



Bellwork
How do you look at images?  How do you look at images on a computer?  What 
can you find out about the images from how you look at images?

Discuss with your neighbors and be prepared to share with the class.



Objective
Students will be able to:

● Understand the different parts of Adobe Bridge’s workspace.
● Navigate through their photos on Bridge.
● Be able to organize their photos.
● Utilize Adobe Bridge before the editing process in Adobe Photoshop.



What is Adobe Bridge?
Adobe Bridge is a companion program for Photoshop. Bridge is often referred to 
as a digital asset manager, or a media manager. That's because Adobe Bridge 
gives us powerful ways to find, manage and organize our ever-growing collection 
of images. In fact, Bridge isn't limited to just photos, or just Photoshop. Adobe 
Bridge is a companion program for every app in the Adobe Creative Cloud (or the 
Creative Suite). We can use Bridge to manage not just images but also Adobe 
Illustrator files, InDesign files, videos, and more! 

Since this is a Photography class using Photoshop, we'll focus on how we can use 
Bridge with our photos.



Adobe Bridge Features Overview
Before we look at what we can do in Adobe Bridge, let's quickly go over some of 

the many great features that Bridge has to offer.



Bridge is a File Browser
At its most basic, Adobe Bridge is a file browser. Bridge is similar in many ways 
to the file browser you use with your computer's operating system(Finder in Mac 
which we use as well as iPhoto which we do NOT use). 

We can use Bridge for the following:

● Find images we're looking for on our computer. 
● Copy or move images from one folder to another. 
● Copy or move entire folders from one location to another. 
● Create new folders, rename folders and images, and delete folders and images.

Every basic function we can perform using our operating system's file browser, we 
can do with Adobe Bridge.



Bridge is a File Management System
If we can already do these things with our normal file browser, why bother learning 
how to do them in Bridge? The reason is simple. Bridge isn’t just a file browser. 
Adobe Bridge is a complete file management system. To begin, Bridge can 
display thumbnail previews of all the images in a folder. The thumbnails in Bridge 
are fully customizable. We can adjust the size of the thumbnails in Bridge just by 
dragging a slider. Bridge can also display more information about an image (the 
file name, pixel dimensions, date created, copyright info, and more) below its 
thumbnail.



Bridge is a File Management System(continued)
Also, Bridge lets us easily change the sort order of the images. We can order 
images by file name, file type, the date each file was created or modified, or by file 
size or dimensions. We can also order images by star rating or some other 
criteria. And we can manually change the sort order just by dragging the 
thumbnails around!



Bigger and Better Image Previews
Along with changing the size of the thumbnails, Bridge gives us other ways to 
preview our images. 

The Preview panel in Bridge displays a larger preview of each image we select.

One of the best features of Bridge is the Full Screen Preview mode(It lets us 
instantly jump to a full screen view of any image for a closer look!).



Adding Ratings and Labels to Images
One of the ways we can sort our images in Bridge is by star rating. Bridge lets us 
quickly apply ratings to our images using a one-to-five-star system. An image you 
absolutely love may get five stars, while another image that's "okay but needs 
work" may get only one star. Other images that are you don’t want to edit may get 
no stars at all. Or you can label an image as "Reject" if it you want to get rid of 
it(Things like completely overexposed, etc).

Along with star ratings, Adobe Bridge also lets us apply color labels to images. A 
yellow label can indicate images that still need work. Green can be used for ones 
that have already been approved. We can choose the meaning of each color 
ourselves, so how you want to label or use them is up to you.



Adding Keywords and Copyright Information
Bridge lets us add important copyright information to our photos. 

We can view and edit a whole range of additional information (metadata) about 
our images. 

We can create and apply keywords to our images with Bridge, making it easier for 
us (and others) to find those images when we need them.



Filtering Images and Creating Collections
Bridge can filter images to show us the photos that meet certain criteria we’re 
looking for. We can view only images with a five star rating. Or only the images 
shot with a certain lens, or at a certain focal length. 

Bridge can combine photos into collections that make it easy for us to group 
related images together. Collections can even group images that are scattered 
across different folders or even different hard drives. And smart collections in 
Bridge act like dynamic search results. Smart collections tell Bridge to 
automatically add any images to the collection if and when they meet the criteria 
we specify.



Batch Renaming Files
The Batch Rename feature in Bridge lets us quickly rename multiple files at once. 
Batch Rename lets us rename our files after we've deleted the ones we don't want 
to keep. This means there won't be any breaks in the naming sequence (which 
makes it look like some of the images are missing).  Mr. Nistas gave you a 
handout with instructions on how you need to rename your photos for this class.



Making Contact Sheets

(Contact sheets for this class are 5 
columns, 6 rows, with the sheet being 
8.5 wide, 11 long, with the units being in 
inches.  Make sure to have Use 
Filename as Caption selected with Font: 
Arial, Regular, 12pt)

There are two different ways to do this.

You can make contact sheets through Adobe Bridge.  This is what you do after each 
shoot after you’ve renamed your photos to show the photos you’ve taken for 
projects.  It creates a sheet with thumbnails of all of your photos.



Quick Access to Photoshop
Bridge makes it easy to open our images into Photoshop. But Bridge also gives us 
access to some of Photoshop's powerful image processing commands. Lens 
Correction, Merge to HDR Pro, Photomerge and others are all available from 
directly within Bridge itself. Adobe Bridge is also the best way to open images into 
Photoshop's image editing plugin, Camera Raw.

To open in Camera Raw, have a photo selected and do one of the following:

● File ➤ Open in Camera Raw
● Click on the Aperture Ring on the Application Bar
● Right click on the image and select Open in Camera Raw 
● Double click on the image if it is a .CR2 file



How to Launch Adobe Bridge
Even though Bridge may be a companion app for Photoshop, Bridge is actually its 
own separate program. We can open Bridge the same way we open Photoshop or 
any other program on our computer. On our computers, Bridge is found in the 
Applications folder. You can even save it to the Dock for easy access.  

Photoshop does not need to be open to start Bridge. But Bridge can be opened 
from within Photoshop.



Opening Bridge through Photoshop
In Photoshop, open Bridge by going up 
to the File menu and choosing Browse 
in Bridge. Bridge can also be opened 
from the keyboard shortcut:
Command + Option + O. 

Quick Tip:  The keyboard shortcut will switch you 
back and forth between Photoshop and Bridge 
each time you press it.



A

B

D

C

E

F
G



Adobe Bridge Interface
Like Photoshop, Adobe Bridge provides a collection of panels:

● The Folders panel in the upper left lets you navigate through the folders and directories on your 
computer to find your images.  Along with the Folders panel is the Favorites panel which gives you 
quick access to the folders and directories you use the most.

● The Content panel in the center displays thumbnails of your images.
● In the upper right is the Preview panel, showing a larger preview of whichever thumbnail is 

selected. 
● Metadata about your images, including copyright information, can be viewed and edited in the 

Metadata panel. 
● The Keywords panel lets us create keywords and apply them to our photos. 
● The Filter panel makes it easy to filter images so we're only seeing the ones we need.
● The Collections panel lets us group related images together.
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A - Folders and Favorites Panels



A - Folders and Favorites Panels
The Folders panel is our main way of navigating 
to our images.

● The Folders Panel displays the folders on your computer 
in a familiar and easy-to-use "tree" structure. 

The Favorites panel lets us quickly access the 
folders and file locations we use the most, just like 
bookmarks in your web browser!

● All you need to do is drag a folder to this area to save it as 
a Favorite.



Folders and Favorites Panels(Continued)
Adobe Bridge groups related panels together to save space, just like Photoshop 
does. And just like in Photoshop, we can switch between panels in a group by 
clicking on the name tabs along the top of the group.  

By default, Bridge adds some common file locations to the Favorites panel, like 
your Desktop, Documents folder and Pictures folder. We can quickly jump to any 
of these locations by clicking on them. We can also add our own folders and file 
locations to the Favorites panel. 



The Folders Panel
To switch from Favorites to the Folders 
panel, click on the Folders tab.

The Folders panel is our main way of 
navigating to our images. 

● This lets us navigate down through our folders 
to get to the files we need.

● Clicking the triangle to the left of a folder will 
expand that folder open, revealing the folders 
inside it. 
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B - The Path Bar



B - The Path Bar
The Path Bar along the top of the Bridge interface is another way to see the 
current file location. Here you can see that the current location is the JPEG folder 
which is inside the photos folder on the Desktop. The Path Bar also allows users 
to quickly jump to any other location along the path. 

For example, if you wanted to jump to your Desktop, all you would need to do is click on Desktop in the 
Path Bar and Bridge would take you right there.  

Clicking on the Triangle to the right of the location will show you any folder that might be in that location.
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C - Application Bar



C - Application Bar
The Application Bar provides buttons for essential tasks like creating PDF contact 
sheet, navigating the folder hierarchy, switching workspaces, and searching for 
files.  Bridge also gives the familiar Back and Forward buttons in the upper left 
corner. These buttons act just like the Back and Forward buttons in web browsers. 
Use them to move back and forth through your navigation history.
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D - The Content Panel



D - The Content Panel
Once you have navigated to your images using the Folders or Favorites panel, 
they appear as thumbnails in the Content panel. The Content panel is the largest 
panel in Bridge, taking up the entire section in the middle. Here you will see 
thumbnail previews of all the images inside the JPEG folder.



Slider
The slider along the bottom right of the Bridge interface makes it easy to adjust the 
size of the thumbnails. Drag the slider to the right to make the thumbnails larger. 
Drag to the left to make them smaller. There's also an icon on either side of the 
slider bar. Clicking the icons will increase (+) or decrease (-) the thumbnail size 
incrementally.



Larger Thumbnails
You will see that after dragging the 
slider to the right, the thumbnails are 
now much larger. They are so large that 
only a few of them can fit within the 
Content panel's viewable area. 

The scroll bar along the right of the 
Content panel lets you scroll through 
your thumbnails when they're either too 
large, or when there's too many to fit on 
the screen at once.
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E - The Preview Panel



E - The Preview Panel
To select an image in the 
Content panel, click one of 
the image thumbnails. 

A preview of the image will 
appear in the Preview 
panel in the upper right of 
the Bridge interface.



Resizing Panels in Bridge
If the preview is too small, you can easily resize the Preview panel to make it 
larger. You can resize any of the panels in Bridge in the same way. 

1. Hover your mouse cursor over the vertical or horizontal divider line on the left, 
right, top or bottom of a panel. 

2. Your cursor will change into a resize icon with two arrows pointing in opposite 
directions. 

3. Click and drag the divider line to resize the panel as desired. 

You will notice that as you resize the Preview panel, the image inside the panel 
resizes along with it.





Customizing the Interface
Increasing the size of one panel in 
Bridge decreases the size of other 
panels (since there's only so much room 
on the screen). In this situation, by 
making the Preview panel larger, the 
Content panel is smaller. 

You can customize the interface 
however you prefer.



Full Screen Previews
The Preview panel isn’t the only option 
to review your images.  There is also 
the Full Screen Preview option in 
Bridge. 

With a thumbnail selected in the 
Content panel, go up to View in the 
Menu Bar and choose Full Screen 
Preview. Or just press the spacebar on 
the keyboard.



Full Screen Previews
This brings up the image to a full screen 
view, with the entire image fitting on the 
computer screen. If the aspect ratio of 
the image isn't the same as the aspect 
ratio of the computer screen, there will 
be gray bars either on the sides or 
along the top and bottom.



The 100% View
Clicking on the image while in the full screen 
view will zoom in to a 100% view. In the 
100% view, each pixel in the image takes up 
exactly one screen pixel. This way is an easy 
way to judge the sharpness and focus of the 
image. 

● Click and drag the image around while in the 
100% view mode to view and inspect different 
areas. 

● To zoom back out, click once again on the 
image. 

● To exit Full Screen Preview mode completely, 
press the spacebar again on the keyboard.



Rating Images
To make it easy to separate good images from bad, Bridge allows users to apply 
ratings to images. It uses a ★ to ★★★★★ rating system. 

To select multiple images at once, press and hold the Command key on the 
keyboard and click on the images needed. 

If all the images needed are in a continuous row, click on the first image to select 
it, then press and hold the Shift key and click on the last image. This will select all 
of the images from the first image to the last.



Ratings Images
Notice that with three images selected in the Content panel, the Preview panel is 
displaying larger previews of all three images. The Preview panel can display up 
to 9 images at a time.



Stars
To use the ★ to ★★★★★ rating 
system, do the following:

● Select the image
● Go to Label in the Menu Bar 
● From there, choose ★, ★★, 

★★★, ★★★★, or ★★★★★. 
● Choose No Rating to clear the 

previous rating from the image. 
● For images that won’t be usable, 

choose Reject.



Five Stars
Notice the three images here now show a five star rating below their thumbnails.



Filtering Images by Star Rating
Once some images are rated, they can 
be filtered in the Content panel to show 
only images with a certain rating. 

1. Click the Filter Items by Rating 
icon (the ★) in the upper right of 
the Bridge interface. 

2. Choose an option from the 
dropdown menu.



Filtering Images by Star Rating(Continued)
Now only those three images with a 5 star rating remain in the Content panel. 
Images with fewer than 5 stars, or no rating at all, are temporarily hidden.  Another 
option choose from is to view only rejected images, or images with no rating. Or 
view only images with or without a color label assigned to them.



Clearing the Filter
To view all of the images again, click on 
the Filter Items by Rating icon(★) and 
choose Clear Filter from the top of the 
menu.



Labels
You can also Label photos to stand out 
with colors.  Select, Second, Approved, 
Review, and To Do are the default 
names, but you can always change 
them to different names if you want.
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F - Metadata/Keywords



F - The Metadata Panel
Below the Preview panel on the right is the Metadata and 
Keywords panels tabbed together. Both of these panels 
are very useful. 

The Metadata panel displays information about an image. 
The shot date, camera settings that were used, and the 
file size and type are displayed here. The image's color 
mode and bit depth, whether or not the flash fired, and 
others can also be found here. The Metadata panel can 
also be used to add additional details to the image, like 
copyright and contact info. 

Use the scroll bar along the right to scroll through all the 
details and click on the various category headings (File 
Properties, IPTC Core, etc) to open and close them.



F - The Keywords Panel
The Keywords panel tab is beside the Metadata 
panel tab. Click on the Keywords tab to open it. 
The Keywords panel lets users create descriptive 
keywords and assign them to images. Later, those 
keywords can be searched to find those images. 

To add a new keyword, click the New Keyword 
button at the bottom, then type in a keyword. To 
assign an existing keyword to an image, select the 
image in the Content panel. Then, click inside the 
checkbox of the keyword needing to be assigned. 
Multiple keywords can be assigned to the same 
image. To remove a keyword, select the image in 
the Content panel, then uncheck the keyword.
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G - Filter/Collections Panel



G - The Filter Panel
Below the Favorites and Folders panel on the left of Bridge is the Filter panel. 
The Filter panel can be used to filter images by keyword, the date created, 
whether the image is in landscape or portrait orientation, by aperture, shutter 
speed and ISO settings, focal length, and more. It can even filter images by 
camera model or the particular lens that was used.



G - The Filter Panel
To use the Filter panel:

● Click on the various category headings to 
open and close them. 

● Click on any of the filter options in the 
category to select them. 

(Note: there won't always be every filtering option listed. 
That's because the Filter panel in Bridge is dynamic. The 
options listed are based on the images currently in the 
selected folder. For example, it may be that all of the images 
in the folder use landscape orientation. Since none of them 
use portrait orientation, the Portrait option will not be 
displayed in the Orientation category)



Other Workspaces



Essentials(What we’ve seen already)



Filmstrip(What Mr. Nistas usually uses)



Output(How you make Contact Sheets)



Metadata(How to see Photo Info)



Keywords(How to see Photo Keywords)



How to Change Workspaces
To switch between the Workspaces, you can either go to the Application Bar and 
choose between Essentials, Filmstrip, Output, Metadata, Keywords, and the 
dropdown menu(which allows you to reset your workspaces to default).  You can 
also go to Window ➤ Workspace for the same options.



Closure
What do you initially think of Adobe Bridge?

What do you use to rename images for this class?

What is a contact sheet?

Are you ready to learn about Photoshop?


